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1 Checking the PostScript® Kit Contents

The devices and components of the kit are described below.
If any of the following are missing, contact the Xerox Welcome Center.

PostScript Program ROM
This ROM makes PostScript printing possible with the printer. 

1 PostScript Driver Library CD-ROM
Includes the PostScript drivers and screen fonts.

Documentations
• License Agreement 

• Single sheet (PostScript DC readme sheet) 

• PostScript Kit Installation Guide
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2 Operation with Windows 95/98/Me

The following information can be found in this chapter:

• About the Software
– Bundled Software
– Hardware/Software Requirements

• Installing the Adobe PostScript Printer Driver
– Installation Procedure

• Printer Driver Properties
– Configuration Tab Settings
– Options Tab Settings
– Color Settings Tab Settings
– Output Settings Tab Settings

• How to Use Help

About the Software

This section describes the software for Windows 95, Windows 98, and Windows Me 
included on the PostScript Driver Library CD-ROM.

Bundled Software
The following items are included on the enclosed CD-ROM.
Adobe PostScript Printer Driver (ver. 4.5.3) and PPD files - Adobe PostScript driver 
and PPD files (for Windows 95/98/Me).
ATM (Adobe Type Manager) (ver. 4.1) - Helps you to install typefaces and activate 
and manage your fonts.
Adobe Screen Fonts (TrueType/PostScript) - Includes 136 screen fonts (19 
TrueType fonts and 117 PostScript fonts), which are compatible with the printer fonts. 
ATM is used to install the PostScript screen fonts. When using these fonts to print, it is 
recommended that you use the Adobe PostScript (4.5.3) printer driver.
Adobe Reader - Allows you to view and print PDF files on all major computing 
platforms.
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Hardware/Software Requirements
The minimum system requirements for the Windows 95/Windows 98/Windows Me 
printer driver are described below.

Computer System
Personal computer in which the Windows 95/Windows 98/Windows Me OS can 
operate.

Basic Software
Windows 95, Windows 98 or Windows Me

Installing the Adobe PostScript Printer Driver

Install Adobe PostScript 4.5.3 printer driver onto Windows 95, Windows 98 or Windows 
Me by following the procedure below.
This section describes how to install the printer driver for Windows 98, as an example.
It is possible to cancel installation of the printer driver by clicking [Cancel] in the dialog 
box displayed during installation. You can also click [Back] to ignore the settings in that 
dialog box and return to the previous dialog box. 

Installation Procedure

1. Start Windows 98.

2. On the Start menu, point to Settings and click [Printers]. 

3. In the Printers window, double-click [Add Printer]. 

4. Click [Next]. 

5. Select how the printer is connected to the computer and click [Next]. 
Select [Local printer] when the printer is connected directly to the computer. 
Otherwise, select [Network printer]. The following is an example of a local printer.

NOTE: When you select [Network printer], specify the path to the printer in the 
network path or queue name box.

6. Insert the PostScript Driver Library CD-ROM in your CD-ROM drive.

7. Click [Have Disk]. 

8. Enter “Drive Name:\English\PrinterDriver\win9x_Me” in the “Copy manufacturer’s 
files from:” box and click [OK].
In this guide, we have used “E:” as the CD-ROM drive. If you are using a different 
drive for the CD-ROM, specify accordingly.

NOTE: Click [Browse] to specify a folder on the CD-ROM. 

9. Select your printer model from the Printers list and click [Next].
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NOTE: When Finisher C or Finisher C with Booklet Output Tray is installed, select the 
model number with ‘C’ at the end.

10. Select the port that you are using and click [Next]. 

11. Type a name for the printer and specify whether you want to use the printer as the 
default printer, then click [Next].

12. Specify whether to print a test page, then click [Finish].

Installation begins.

13. Read the End User License Agreement and click [Agree].

If you click [Disagree], see If you click Disagree in the License Agreement on 
page 11 for details. 

14. Confirm that a printer has been added in the Printers window. 

This completes installation of the printer driver. Remove the CD-ROM from the 
drive.
See Printer Driver Properties on page 11 to configure the printer.
Store your CD-ROM in a safe place.

If you click Disagree in the License Agreement
Click [No] to return to the operation and continue.
Click [Yes] to cancel the installation. A printer is added to the Printers window, but the 
printer driver is not installed properly.
When you right-click the printer and click [Properties] from the menu, the Re-installation 
tab is added to the printer driver properties dialog box. Follow the directions on that tab. 
When you finish reinstalling the printer driver, see Printer Driver Properties on page 11 
to set up the printer.

Printer Driver Properties

This section describes printer specific settings included in the printer driver properties.

• Configuration Tab

• Options Tab

• Color Settings Tab

• Output Settings Tab
NOTE: You can also refer to Help for explanations of these settings. See How to Use 
Help on page 18 for details about how to use Help.

To view the printer driver properties, select the printer icon in the Printers window, then 
click [Properties] on the File menu.
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Configuration Tab Settings
This section describes the settings of the Configuration tab.
Select the function that you want to set in the Features List and change the settings in 
the Change box below.

NOTE: You can restore defaults by clicking [Defaults].

NOTE: The settings that can be selected vary depending on which options have been 
installed. Change these settings only after confirming that the option settings are 
complete. See Options Tab Settings on page 14.

Settings
Collated - Selects whether to collate a printed sets from a multiple-page file.
Stapling - Specifies the stapling location and number of staples. This option requires 
an optional Finisher unit.
NOTE: You can use staples only when a Finisher Tray is selected for Output bin in the 
Paper tab.

Hole Punch - Specifies the punching position. The holes are made based on the output 
orientation of the paper. As a result, the holes may not be punched correctly depending 
on the position of the image. (PS C-series only)
Hole Punch Settings - Specifies the number of holes to punch. (PS C-series only)
Fold - Specifies the folding method. (PS C-series only)
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Offset - The position of individual jobs or sets of copies are shifted to either side of the 
output tray to enable easy separation.
Feed Orientation - Specifies the paper orientation when printing from the bypass tray. 
When feeding the short edge of the paper first, select [Landscape]. When feeding the 
long edge of the paper, select [Portrait].
Front Cover - Specifies the paper tray that the front cover stock is to be fed from.
Back Cover - Specifies the paper tray that the back cover stock is to be fed from.
Print on Separators - Specifies whether to print on the transparency separators as 
well as the transparency.

Separator Paper Supply - Specifies the paper tray that transparency separators 
are to be fed from. When [Auto Paper Select] is selected, the tray set on the machine 
is used as the feed destination.

Print Mixed Sized Originals - Specifies whether you are printing mixed sized originals 
for 2 Sided Print.
Image Enhancement - Specifies whether to use the Image Enhancement function. 
Selecting [On] smoothes out boundaries when printing. This reduces jagged edges by 
artificially increasing the resolution of the image. When printing a bitmapped image 
composed of coarse halftone dots, smooth color gradation is impossible in certain 
situations. In this case, select [Off].
Draft Mode - Specifies whether to reduce the amount of toner used when printing 
drafts. When [On] is selected, the overall printed color becomes lighter. This is best for 
printing documents when high print quality is not necessary.
Substitute Tray - Specifies what action to take when the paper for the print size is not 
loaded in the machine.

Printer Default - Use the printer settings. The settings can be confirmed on the 
control panel.
Display Message - Display paper supply messages on the control panel. Printing 
is impossible until paper is supplied.
Use Closest Size (Reduce to Fit) - Selects the closest paper size and automatically 
adjusts the image size as necessary.
Use Closest Size (100%) - Selects the closest paper size and prints the same size 
as the image.
Use Larger Size (Reduce to Fit) - Selects paper larger than the original and 
automatically adjusts the image size as necessary.
Use Larger Size (100%) - Selects paper larger than the original and prints the same 
size as the image.
Select Tray 5 (Bypass) - Feeds from bypass tray.

Skip Blank Pages - Specifies whether to skip blank pages when printing documents 
that contain blank pages.
Custom Paper Auto Orientation - Specifies whether to correct the orientation when 
printing to a custom paper size.
Brightness - Adjusts the level of brightness applied to the printed images.
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Available Printer Memory - Enter the amount of usable printer memory (in KB) in the 
Edit box. Usually, it is not necessary to change this.
Available Font Cache - Enter the amount of memory available for the font cache (in 
KB) in the Edit box. Usually, it is not necessary to change this.
Account Mode - Specifies if all users or only System Administrators can change 
authentication related settings.

Options Tab Settings
This section describes the settings in the Options tab. 
Select the items in Hardware Options and change them in the Change box below. To 
use this function, it is necessary to make appropriate settings in this tab. 

NOTE: You can restore defaults by clicking [Default].

Settings
Paper Tray Configuration - Specifies the paper tray type installed on the machine.
When [4-Tray] is selected, the standard paper trays are installed.
When [4-Tray (High Capacity)] is selected, the high-capacity trays are installed.
Output Options - Specifies whether the Finisher output unit is installed for WorkCentre 
7228/7235/7245 PS printers, and whether the Finisher (2 Holes/4 Holes) or Finisher (3 
Holes) is installed for WorkCentre 7228/7235/7245 PS C-series printers.
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Booklet Output Tray - Specifies whether the Booklet Output Tray (optional) is 
installed. (PS C-series only)
Memory - Specifies the amount of printer memory.

Color Settings Tab Settings
This section describes the settings in the Color Settings tab. 

NOTE: You can restore defaults by clicking [Defaults].

Settings
Output Color - Specifies printing in full color mode or black and white mode.
Image Quality - Specifies the print quality of the document. Select [High Speed] for 
quick output, [High Quality] for high quality output regardless of the speed, or [High 
Resolution] for printing in Decomposer resolution. 
Image Types - Specifies the color adjustment printing mode optimized for the input 
type.

Standard - Printing is optimized for business documents containing text and graphs.
Photos - Printing is optimized for high-gradation images to best reproduce photos.
Presentation - Printing is optimized for presentation materials to produce vivid 
colors.
Web Pages - Printing is optimized for low-resolution images such as web pages and 
screen displays.
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CAD - Printing is optimized for reproducing fine lines and colored text.
Off - Printing occurs with no color adjustment.

Advanced
Screen - Specifies the printer engine screening mode.
RGB Gamma Correction - Specifies the color adjustment input source gamma value.
Gray Guaranteed - Specifies printing of achromatic colors in non-raster image areas 
with black toner only.
Display warning message about Color Settings - When checked, the printer driver 
displays the Optimum Color Settings dialog box if an image color matching option is 
selected on the Graphics tab. The Image Color Matching settings are only available 
when an ICC profile is linked in the Color Management tab.

Output Settings Tab Settings
This section describes the settings in the Output Settings tab. 

NOTE: You can restore defaults by clicking [Defaults].

Job Type
You can specify the print function for Secure Print, Sample Set, and Delayed Print.
Secure Print temporarily stores print jobs in the printer, and then prints them when print 
instructions are received from the control panel.
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Sample Set outputs only one copy when multiple copies are specified. If there is no 
problem, the remaining sets can be printed.
Delayed Print temporarily stores print jobs in the printer, and then prints them at the 
scheduled time.
To use Secure Print, Sample Set, or Delayed Print feature, input the User ID and 
passcode for Job Type. The passcode entered appears as asterisks (*).
Normal Print - Select when you do not want to output secure prints, a sample set, or 
delayed prints.
Secure Print - Select when you want to output secure prints.
Sample Set - Select when you want to output a sample set.
NOTE: The Collated setting must be selected in the Page Setup tab, under the 
application's File menu, when using Job Type.

Delayed Print - Select when you want to output delayed prints.
See the On-line Help for details on the operation of the printer.
User ID - Displays the User ID for Secure Print and Sample Set. The user ID should be 
of maximum 24 characters.
Passcode - Enter the passcode for Secure Print. Each digit entered appears as an 
asterisk (*). Enter the passcode within 12 digits.
Retrieve Document Name - In Secure Print, Sample Set, and Delayed Print, select the 
method to retrieve the name of the documents stored in the printer. Select [Auto 
Retrieve] or [Enter Document Name]. If [Auto Retrieve] is selected, the document name 
will be obtained from the application that sends the print command. No manual entry is 
allowed. Document names that have exceeded 24 characters will be truncated. If you 
have selected [Enter Document Name], enter a name in the [Document Name] text 
field.
Document Name - This item is used when [Enter Document Name] is seleced for 
[Retrieve Document Name]. Enter the name of the document stored in the printer. The 
name entered should be within 24 characters.
Start Print Time - Specifies the time that a Delayed Print job will be printed. Place the 
cursor in the hour or minute box and press the up or down triangle to specify the start 
time. You can also set the time by entering the time directly into the boxes. The default 
setting is 00:00.

Settings
Fit to New Paper Size - Specifies the paper size on which to print the image. The 
output is automatically enlarged or reduced, depending on the paper size selected here 
and the paper size selected in the Paper tab.
For example, when you select [B5] in Paper Size on the Paper tab, and select [A4] as 
the new size, the output is automatically enlarged and printed.
When you select [None], the job is printed based on the Paper Size selected in the 
application.
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Banner Sheet - Specifies whether to add a banner sheet to the printed output.
When [Printer Default] is selected, the printer settings are used.
When [Print Start Page] is selected, outputs the banner sheet using the start-sheet.
E-mail Job Confirmation - Specifies whether to use the Mail Notify feature to notify 
the end of the print job via e-mail. Default is [Off].

Enter E-Mail Address - Specifies the e-mail address for the Mail Notify feature.
Display warning message about Output Settings - When printing, the printer driver 
checks whether the Output Size setting conflicts with other settings.
When this is activated, a dialog box appears if there is a conflict during printing. Check 
the content of the dialog box and resolve the conflicting function to continue printing.
When this is inactive, no conflict dialog box appears, but the conflicting setting is 
automatically resolved and printing continues.
Image Rotation 180 Degrees - Set the checkbox to rotate the prints by 180°. Default 
is [No Rotation].

Status
The printer status can be monitored by selecting the [Status] button on the [Output 
Settings] tab.

How to Use Help

The following describes how to use Help. 

1. Click  and a ? mark appears next to the pointer. You can then click items for 
which you need explanations, opening a pop-up window that contains relevant 
information. Click inside the pop-up window to close it. 

2. Click [Help], an explanation of the current tab appears as Help information.
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3 Operation with Windows NT 4.0

The following information can be found in this chapter:

• About the Software
– Bundled Software
– Hardware/Software Requirements

• Installing the Adobe PostScript Printer Driver
– Installation Procedure

• Device Options and Print Settings
– Device Settings Tab Settings
– Configuration Tab Settings
– Advanced Tab Settings
– Paper/Output Tab Settings
– Image Options Tab Settings
– Layout Tab Settings

• How to Use Help

About the Software

This section describes the software for Windows NT 4.0 that is included on the 
PostScript Driver Library CD-ROM.

Bundled Software
The following items are included on the CD-ROM.
Adobe PostScript Printer Driver (ver. 5.2.2) and PPD files - Adobe PostScript driver 
and PPD files (for Windows NT 4.0).
ATM (Adobe Type Manager) (ver. 4.1) - Helps you to install typefaces and activate 
and manage your fonts.
Adobe Screen Fonts (TrueType/PostScript) - Includes 136 screen fonts (19 
TrueType fonts and 117 PostScript fonts), which are compatible with the printer fonts. 
ATM is used to install the PostScript screen fonts. When using these fonts to print, it is 
recommended that you use the Adobe PostScript (5.2.2) printer driver.
Adobe Reader - Allows you to view and print PDF files on all major computing 
platforms.
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Hardware/Software Requirements
The minimum system requirements for the Windows NT 4.0 printer driver are described 
below.

Computer System
Personal computer in which the Windows NT 4.0 OS can operate.

Basic Software
Windows NT Workstation 4.0/Windows NT Server 4.0 (Service Pack 6a or later)

Installing the Adobe PostScript Printer Driver

Install the Adobe PostScript 5.2.2 printer driver onto Windows NT by following the 
procedure below.
It is possible to cancel installation of the printer driver by clicking [Cancel] in the dialog 
box displayed during installation. You can also click [Back] to delete the settings in that 
dialog box and return to the previous dialog box.

Installation Procedure

1. Start Windows NT 4.0.

NOTE: Log on as a Power User group member or an Administrator. Refer to the 
Windows NT 4.0 documentation for details about the Power User group.

2. On the Start menu, point to Settings and click [Printers].

3. In the Printer window, double-click [Add Printer].

4. Select how the printer is connected to the computer and click [Next]. Select [My 
Computer] if the printer is connected directly to the computer or to the network in 
the TCP/IP(LPD) environment. Select [Network printer server] in other cases. The 
following is an example of a local printer.

NOTE: Specify the target printer in the Connect to Printer dialog box if you selected 
[Network printer server].

5. Select the port you are using and click [Next]. 

6. Insert the PostScript Driver Library CD-ROM in the CD-ROM drive. 

7. Click [Have Disk]. 

8. Enter “Drive Name:\English\PrinterDriver\NT40” in the “Copy manufacturer’s files 
from:” box and click [OK].
In this guide, we have used “E:” as the CD-ROM drive. If you are using a different 
drive for the CD-ROM, specify accordingly.

NOTE: Click [Browse] to specify a folder on the CD-ROM.
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9. Select your printer model from the Printers list and click [Next].

NOTE: When Finisher C or Finisher C with Booklet Output Tray is installed, select the 
model number with ‘C’ at the end.

10. Enter the printer name, specify if you want to use the printer as the default printer, 
and click [Next].

11. Select [Not shared] and click [Next].

We recommend that you install the driver on each computer with the procedure 
appropriate to the Operating System.

12. Specify whether to print a test page, then click [Finish].

Installation begins.

13. Read the End User License Agreement and click [Agree].

When you click [Disagree], see If you click Disagree in the License Agreement on 
page 21 for details. 

14. Confirm that the printer has been added in the Printers window.

This completes installation of the printer driver. Remove the CD-ROM from the drive.
See Device Options and Print Settings on page 21 to configure the printer. 
Store your CD-ROM in a safe place.

If you click Disagree in the License Agreement
Click [No] to return to step 13 and continue the operation.
Click [Yes] to cancel the installation. A printer is added in the Printers window, but the 
printer driver is not installed properly. 
Select the printer and click [Properties] on the File menu. The Re-installation tab is 
added to the printer driver properties dialog box. Follow the directions on that tab. 
When you finish reinstalling, see Device Options and Print Settings on page 21 to set 
up the printer. 

Device Options and Print Settings

This section describes printer specific settings for printer driver properties and 
document presets.

• Installable Options in the Device Settings Tab

• Configuration Tab

• Printer Specific Sections in the Advanced Tab

• Paper/Output Tab

• Image Options Tab

• Layout Tab
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NOTE: You can also refer to Help for explanations of these settings. See How to Use 
Help on page 31. 

To view the Device Settings or Configuration tabs, select the printer icon in the Printers 
window, then click Properties on the File menu.
To view the Advanced, Paper/Output, Image Options, or Layout tabs, select the printer 
icon in the Printers window, then click Document Defaults on the File menu.

Device Settings Tab Settings
This describes Installable Options in the Device Settings tab. To print correctly, it is 
necessary to make appropriate settings in this tab.
Select the items in Installable Options and change the settings in the Change Setting 
box at the bottom of the tab.

Settings
Paper Tray Configuration - Specifies the paper tray type installed on the machine.
When [4-Tray] is selected, the standard paper trays are installed.
When [4-Tray (High Capacity)] is selected, the high-capacity trays are installed.
Output Options - Specifies whether the Finisher output unit is installed for WorkCentre 
7228/7235/7245 PS printers, and whether the Finisher (2 Holes/4 Holes) or Finisher (3 
Holes) is installed for WorkCentre 7228/7235/7245 PS C-series printers.
Booklet Output Tray - Specifies whether the Booklet Output Tray (optional) is 
installed. (PS C-series only)
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Paper Size Settings - Specifies the paper size group for different areas to enable the 
selection of paper size common to that location.
Color Mode - Specifies the color setting. If [Black] is selected, all colors will be printed 
in black. 
Memory - Specifies the amount of printer memory.

Configuration Tab Settings
This section describes the settings of the Configuration tab. 

NOTE: You can restore defaults by clicking [Defaults].

Settings
Account Mode - Specifies if all users or only System Administrators can change 
authentication related settings.
Detailed User Settings - Sets the authentication information.

Use Default User Settings - The values set in this feature are used as the 
authentication parameters.
– Specify User ID - Select how to specify User ID.
– User ID - Enter a User ID.
– Passcode - Enter the Passcode for the User ID.
– Account ID - Enter an Account ID.
– Billing ID - Enter a User ID for Charge Print.
– Passcode - Enter the Passcode for the Billing ID.
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Prompt User for Settings - Select this feature to display the [Enter User Details] 
dialog-box each time you start printing. The user is then required to enter 
authentication information such as their User ID or Billing ID.
– Display Previous User Details - Check the box to store the user details entered 

in the [Enter User Details] dialog-box, and display the details in the box as a 
default next time.

– Hide User_ID (***) - Check the box to specify whether a user ID is to be displayed 
or hidden when it is entered.

– Hide Account ID (***) - Check the box to specify whether an account ID is to be 
displayed or hidden when it is entered.

High Speed Printing - Set this feature to make improvements in print speed, when 
using an application that generates PostScript directly.
Get Information from Printer - Clicking [Get Information from Printer] when the 
machine is used as a network printer obtains the printer option installation state using 
the print port to which the printer is connected.
Network Address - Displays the network address of the printer when the [Get 
Information from Printer] button is clicked.

Advanced Tab Settings
This section describes the settings in the Advanced tab. Select the items in the 
Advanced tab and change the settings in the Change Setting box at the bottom of the 
tab.
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NOTE: The settings that can be selected vary depending on which options have been 
installed. Change these settings only after confirming that the option settings are 
complete. See Device Settings Tab Settings on page 22.

Settings
Quantity - Specifies the number of output copies.

Collated - Specifies that the output copies be collated.
Image Orientation - Specifies the image orientation, portrait or landscape.
TrueType Fonts - Specifies the font handling for documents containing TrueType 
fonts.

Substitute with Device Font - Substitute TrueType fonts with fonts resident on the 
machine.
Download as Softfont - Download the font to the machine as a softfont.

Reduce/Enlarge - Specifies the reduction/enlargement ratio as a percentage between 
25 and 400%.
Color - Specifies image reproduction in full color or black and white.
PostScript Output Format - Specifies the default PostScript file output format for 
when saving to a file.

Optimize for Speed - For faster printer processing.
Optimize for Portability - Reduce portability errors.
Encapsulated PostScript - Outputs to an encapsulated PostScript file.
Archive Format - Outputs to an archive format file.

TrueType Font Download Method - Specifies the font handling for documents 
containing TrueType fonts.

Automatic - Automatic font handling.
Outline - Include as vector outlines.
Bitmap - Include as bitmap images.
Native TrueType - Include TrueType fonts in their native format.

PostScript Language Level - Specifies the PostScript language level for compatibility 
with other devices (1, 2, or 3).
Print PostScript Error Message - Specifies whether to print PostScript errors when 
an error occurs in a print job.
Mirror Image - Specifies whether to create mirror images for left-hand and right-hand 
pages when printing.
Feed Orientation - Specifies the paper orientation when printing from the bypass tray. 
When feeding the short edge of the paper first, select [Landscape]. When feeding the 
long edge of the paper, select [Portrait].
Offset - The position of individual jobs or sets of copies are shifted to either side of the 
output tray to enable easy separation.
Front Cover - Specifies the paper tray that the front cover stock is to be fed from.
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Back Cover - Specifies the paper tray that the back cover stock is to be fed from.
Transparency Separators - Specifies the separators to be inserted between 
transparencies.

Separator Paper Supply - Specifies the paper tray that transparency separators 
are to be fed from. When [Auto Paper Select] is selected, the tray set on the machine 
is used as the feed destination.
Print on Separators - Specifies whether to print on the transparency separators as 
well as the transparency.
Paper Type (Separators) - Specifies a paper type for the transparency divider.

Image Enhancement - Specifies whether to use the Image Enhancement function. 
Selecting [On] smoothes out boundaries when printing. This reduces jagged edges by 
artificially increasing the resolution of the image. When printing a bitmapped image 
composed of coarse halftone dots, smooth color gradation is impossible in certain 
situations. In this case, select [Off].
Gray Guaranteed - Specifies printing of achromatic colors in non-raster image areas 
in black toner only.
Image Rotation 180 Degrees - Set the checkbox to rotate the prints by 180°. Default 
is [No Rotation].
Skip Blank Pages - Specifies whether to skip blank pages when printing documents 
that contain blank pages.
Draft Mode - Specifies whether to reduce the amount of toner used when printing 
drafts. When [On] is selected, the overall printed color becomes lighter. This is best for 
printing documents when high print quality is not necessary.
Banner Sheet - Specifies whether to add a banner sheet to the printed output.
When [Printer Default] is selected, the printer settings are used.
When [Print Start Page] is selected, outputs the banner sheet using the start-sheet.
E-mail Job Confirmation - Specifies whether to use the Mail Notify feature to notify 
the end of the print job via e-mail. Default is [Off].

Enter E-Mail Address - Specifies the e-mail address for the Mail Notify feature.
Substitute Tray - Specifies what action to take when the paper for the print size is not 
loaded in the machine.

Printer Default - Use the printer settings. The settings can be confirmed on the 
control panel.
Display Message - Display paper supply messages on the control panel. Printing 
is impossible until paper is supplied.
Use Closest Size (Reduce to Fit) - Selects the closest paper size and automatically 
adjusts the image size as necessary.
Use Closest Size (100%) - Selects the closest paper size and prints the same size 
as the image.
Use Larger Size (Reduce to Fit) - Selects paper larger than the original and 
automatically adjusts the image size as necessary.
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Use Larger Size (100%) - Selects paper larger than the original and prints the same 
size as the image.
Select Tray 5 (Bypass) - Feeds from bypass tray.

Custom Paper Auto Orientation - Specifies whether to correct the orientation when 
printing to a custom paper size.
Print Mixed Sized Originals - Specifies whether you are printing mixed sized originals 
for 2 Sided Print.
EMF Spooling - Specifies the spool format of the print data on the hard disk.

Paper/Output Tab Settings
This section describes the settings in the Paper/Output tab. 

NOTE: You can restore defaults by clicking [Defaults].

Job Type
You can specify the print function for Secure Print, Sample Set, and Delayed Print.
Secure Print temporarily stores print jobs in the printer, and then prints them when print 
instructions are received from the control panel.
Sample Set outputs only one copy when multiple copies are specified. If there is no 
problem, the remaining sets can be printed. When only one copy is specified for the 
output, the settings will be changed to [Normal Print] automatically. When multiple 
copies are specified for the output, the remaining copies can be output by an instruction 
from a printer.
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Delayed Print temporarily stores print jobs in the printer, and then prints them at the 
scheduled time.
To use Secure Print, Sample Set, or Delayed Print feature, click the [Setup] button to 
input the User ID and passcode for Job Type. The passcode entered appears as 
asterisks (*).
Normal Print - Select when you do not want to output secure prints, a sample set, or 
delayed prints.
Secure Print - Select when you want to output secure prints.
Sample Set - Select when you want to output a sample set.
Delayed Print - Select when you want to output delayed prints.
See the On-line Help for details on the operation of the printer.
User ID - Displays the User ID for Secure Print and Sample Set. The user ID should be 
of maximum 24 characters.
Enter a 1-12 Digit Secure Print Passcode - Enter the passcode for Secure Print. 
Each digit entered appears as an asterisk (*). Enter the passcode within 12 digits.
Document Name - In Secure Print, Sample Set, and Delayed Print, select the method 
to retrieve the name of the documents stored in the printer. Select [Use Existing Name] 
or [Enter Document Name]. If [Use Existing Name] is selected, the document name will 
be obtained from the application that sends the print command. No manual entry is 
allowed. Document names that have exceeded 24 characters will be truncated. If you 
have selected [Enter Document Name], enter a name in the [New Document Name].
New Document Name - This item is used when [Enter Document Name] is entered in 
[Document Name]. Enter the name of the document stored in the printer. The name 
entered should be within 24 characters.
Start Print Time - Specifies the time that a Delayed Print job will be printed. Place the 
cursor in the hour or minute box and press the up or down triangle to specify the start 
time. You can also set the time by entering the time directly into the boxes. The default 
setting is 00:00.

Settings
Paper Size - Specifies the paper size for printing. When [PostScript Custom Page Size] 
is selected for [Paper Size] on the [Paper / Output] tab, the [Edit...] button becomes 
active. Click this button to specify the dimension for the custom page on the [PostScript 
Custom Size Settings] dialog box. 
Paper Tray - Specifies the paper tray for printing.
Paper Type - Specifies the paper type for printing.
2 Sided Print - Specifies whether to print on both sides of the paper and whether to flip 
the image on the paper.
Output Color - Specifies printing in full color mode or black and white mode.
Stapling - Specifies the stapling location and number of staples. This option requires 
an optional Finisher unit.
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Hole Punch - Specifies the punching position. The holes are made based on the output 
orientation of the paper. As a result, the holes may not be punched correctly depending 
on the position of the image. (PS C-series only)
Hole Punch Settings - Specifies the number of holes to punch. (PS C-series only)
Stapling/Hole Punch for Mixed Sizes - Displays the [Stapling/Hole Punch for Mixed 
Sizes] dialog box. You can specify the settings for stapling (all PS printers) and hole 
punching (PS C-series only) for mixed sized documents.
Fold - Specifies the folding method. (PS C-series only)
Output Destination - Specifies the output tray.

Status
The printer status can be monitored by selecting the [Status] button on the [Paper/
Output] tab.

Image Options Tab Settings
This section describes the settings in the Image Options tab. 

NOTE: You can restore defaults by clicking [Defaults].

Settings
Image Quality - Specifies the print quality of the document. Select [High Speed] for 
quick output, [High Quality] for high quality output regardless of the speed, or [High 
Resolution] for printing in Decomposer resolution. 
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Brightness - Adjusts the level of brightness applied to the printed images.

Basic Features
Image Types - Specifies the color adjustment printing mode optimized for the input 
type.

Standard - Printing is optimized for business documents containing text and graphs.
Photos - Printing is optimized for high-gradation images to best reproduce photos.
Presentation - Printing is optimized for presentation materials to produce vivid 
colors.
Web Pages - Printing is optimized for low-resolution images such as web pages and 
screen displays.
CAD - Printing is optimized for reproducing fine lines and colored text.
Off - Printing occurs with no color adjustment.

Screen - Specifies the printer engine screening mode.
Color Balance - Displays a screen that allows you to adjust the intensity of the color in 
highlights, midtones, and shadows.

Advanced Features/Image Adjustment
RGB Color Correction - Specifies the RGB color correction method.
RGB Gamma Correction - Specifies the color adjustment input source gamma value.
Source RGB Profile - Specifies the display or working color space for accurate 
reproduction of RGB color.
RGB Color Temperature - Specifies the RGB color temperature.
CMYK Color Correction - Specifies the color correction target ink type for CMYK.
Target Paper - Specifies the type of paper for CMYK color correction. This is not the 
paper for printing. 
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Layout Tab Settings
This section describes the settings in the Layout tab. 

NOTE: You can restore defaults by clicking [Defaults].

Settings
Multiple-Up - Prints multiple consecutive pages of a document on a single sheet of 
paper.

Draw Outlines - Draws a border around each page image printed on a single sheet 
of paper using the Multiple-Up feature.

Fit to New Paper Size - Specifies the paper size on which to print the image.
Image Shift - Specifies the image shift position for a binding margin. Specify the edge 
position and the extent of the image shift on [Side 1] of the paper. You can also specify 
a margin for [Side 2] for 2 sided printing along the same edge of the paper.

How to Use Help

The following describes how to use Help. 

1. Click  and a ? mark appears next to the pointer. You can then click items for 
which you need explanations, opening a pop-up window that contains relevant 
information. Click inside the pop-up window to close it.

2. Click [Help], an explanation of the current tab appears as Help information.
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4 Operation with Windows 2000, 
Windows XP and Windows Server 2003

The following information can be found in this chapter:

• About the Software
– Bundled Software
– Hardware/Software Requirements

• Installing the Printer Driver
– Installation Procedure

• Device Options and Print Settings
– Device Settings Tab Settings
– Configuration Tab Settings
– Advanced Tab Settings
– Paper/Output Tab Settings
– Image Options Tab Settings
– Layout Tab Settings

• How to Use Help

About the Software

This section describes the software for Windows 2000, Windows XP and Windows 
Server 2003 included with the PostScript Driver Library CD-ROM.

Bundled Software
The following items are included on the CD-ROM and are necessary when using the 
printer on Windows 2000, Windows XP and Windows Server 2003. 
Microsoft PostScript 5.2 Driver and PPD files - Microsoft PostScript 5 Driver and 
PPD files (for Windows 2000, Windows XP and Windows Server 2003).
Adobe Reader - Allows you to view and print PDF files on all major computing 
platforms.
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Hardware/Software Requirements
The minimum system requirements for the Windows 2000, Windows XP and Windows 
Server 2003 printer driver are described below.

Computer System
Personal computer in which the Windows 2000/Windows XP/Windows Server 2003 OS 
can operate.

Basic Software
• Windows 2000 Professional

• Windows 2000 Server

• Windows 2000 Advanced Server

• Windows XP Professional Edition

• Windows XP Home Edition

• Windows Server 2003

Installing the Printer Driver 

Install MS PostScript 5 printer driver onto Windows 2000, Windows XP and Windows 
Server 2003 by following the procedure below.
This section described how to install the printer driver for Windows 2000, as an 
example.
NOTE: It is possible to cancel installation of the printer driver by clicking [Cancel] in 
the dialog box displayed during installation. You can also click [Back] to delete the 
settings in that dialog box and return to the previous dialog box.

NOTE: If you want to set up Port 9100, refer to the System Administration Guide.

Installation Procedure

1. Start Windows 2000.

NOTE: Log on as a Power User group member or an Administrator. Refer to the 
Windows 2000 documentation for details about the Power User group.

2. On the Start menu, point to Settings and click [Printers].

3. In the Printers window, double-click [Add Printer].

4. Click [Next]. 

5. Select how the printer is connected to the computer and click [Next]. 
Select [Local printer] if the printer is connected directly to the computer or to the 
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network in the TCP/IP(LPD) environment. Otherwise, select [Network printer]. The 
following is an example of a Local printer.

NOTE: When you select [Local printer], deselect the “Automatically detect and install 
my Plug and Play printer” check box.

NOTE: Specify the target printer in the Connect to printer dialog box if you selected 
[Network printer]. 

6. Select the port you are using and click [Next]. 

When the printer is connected in the TCP/IP(LPD) environment:
1) Click [Create a new port].
2) Select Standard TCP/IP Port in the Type list and click [Next].
3) Click [Next]. 
4) Enter the IP address of the printer in Printer Name or IP Address, then click 

[Next]. 
Click [Finish] in the dialog box that will be displayed.

7. Insert the PostScript Driver Library CD-ROM in the CD-ROM drive. 

8. Click [Have Disk]. 

9. Enter “Drive Name:\English\PrinterDriver\win2000” in the “Copy manufacturer’s 
files from:” box and click [OK].
In this guide, we have used “E:” as the CD-ROM drive. If you are using a different 
drive for the CD-ROM, specify accordingly.

NOTE: Click [Browse] to specify a folder on the CD-ROM. 

10. Select your printer model from the Printers list and click [Next]. 

NOTE: When Finisher C or Finisher C with Booklet Output Tray is installed, select the 
model number with ‘C’ at the end.

11. Enter the printer name, set whether you want to use it as the default printer, and 
click [Next]. 

12. Select [Do not share this printer] and click [Next]. 

We recommend that you install the driver on each computer with the procedure 
appropriate to the Operating System. 

13. Specify whether to print a test page, then click [Next]. 

14. After confirming the settings displayed, click [Finish]. 

NOTE: If the dialog box “Digital Signature Not Found” appears, click [Yes] to continue 
the installation.

Installation begins.

15. Confirm that the printer has been added in the Printers window. 

This completes the installation of the printer driver. Remove the CD-ROM from the 
drive.
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See Device Options and Print Settings on page 36 to configure the printer. 
Store your CD-ROM in a safe place.

Device Options and Print Settings

This section describes printer specific settings for printer driver properties. For other 
items, refer to the Help.

• Installable Options in the Device Settings Tab

• Configuration Tab

• Printer Specific Sections in the Advanced Tab

• Paper/Output Tab

• Image Options Tab

• Layout Tab
NOTE: You can also refer to Help for explanations of these settings. See How to Use 
Help on page 47. 

To view the Device Settings or Configuration tabs, select the printer in the Printers 
window, then click [Properties] on the File menu.
To view the Advanced, Paper/Output, Image Options or Layout tabs, select the printer 
icon in the Printers window, then click Document Defaults on the File menu.
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Device Settings Tab Settings
This section describes Installable Options in the Device Settings tab. To print correctly, 
it is necessary to make the appropriate settings in this tab. 
Select the items in Installable Options and change the settings in the menu that 
appears on the right. 

Settings
Paper Tray Configuration - Specifies the paper tray type installed on the machine.
When [4-Tray] is selected, the standard paper trays are installed.
When [4-Tray (High Capacity)] is selected, the high-capacity trays are installed.
Output Options - Specifies whether the Finisher output unit is installed for WorkCentre 
7228/7235/7245 PS printers, and whether the Finisher (2 Holes/4 Holes) or Finisher (3 
Holes) is installed for WorkCentre 7228/7235/7245 PS C-series printers.
Booklet Output Tray - Specifies whether the Booklet Output Tray (optional) is 
installed. (PS C-series only)
Paper Size Settings - Specifies the paper size group for different areas to enable the 
selection of paper size common to that location.
Color Mode - Specifies the color setting. If [Black] is selected, all colors will be printed 
in black. 
Memory - Specifies the amount of printer memory.
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Configuration Tab Settings
This section describes the settings of the Configuration tab. 

NOTE: You can restore defaults by clicking [Defaults].

Settings
Account Mode - Specifies if all users or only System Administrators can change 
authentication related settings.
Detailed User Settings - Sets the authentication information.

Use Default User Settings - The values set in this feature are used as the 
authentication parameters.
– Specify User ID - Select how to specify User ID.
– User ID - Enter a User ID.
– Passcode - Enter the Passcode for the User ID.
– Account ID - Enter an Account ID.
– Billing ID - Enter a User ID for Charge Print.
– Passcode - Enter the Passcode for the Billing ID.
Prompt User for Settings - Select this feature to display the [Enter User Details] 
dialog box each time you start printing. The user is then required to enter 
authentication information such as their User ID or the Billing ID.
– Display Previous User Details - Check the box to store the user details entered 

in the [Enter User Details] dialog-box, and display the details in the box as a 
default next time.
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– Hide User_ID (***) - Check the box to specify whether a user ID is to be displayed 
or hidden when it is entered.

– Hide Account ID (***) - Check the box to specify whether an account ID is to be 
displayed or hidden when it is entered.

High Speed Printing - Set this feature to make improvements in print speed, when 
using an application that generates PostScript directly.
Get Information from Printer - Clicking [Get Information from Printer] when the 
machine is used as a network printer obtains the printer option installation state using 
the print port to which the printer is connected.
Network Address - Displays the network address of the printer when the [Get 
Information from Printer] button is clicked.
Enable Bi-Directional Communication - Launches the bi-directional communication 
tool. This allows you to check the status of the printer and jobs from a PC.

Bi-Directional Communication Setup
The printer status can be monitored using the Bi-Directional Communication Window, 
displayed by selecting the [Status] button on the [Paper/Output] tab. Once 
communication is established, the setting does not need to be changed.
NOTE: The Bi-Directional Communication function is supported on the Windows 
2000, Windows XP, and Windows Server 2003 operating systems.

NOTE: If any of the following events occur, the Bi-Directional Communication function 
is automatically disabled, and will need to be setup again.

– If the device configuration (for example, Memory Capacity) is changed,
– If [Get Information from Printer] is selected, and acquiring device information 

fails,
– If [Enable Bi-Directional Communication] checkbox is selected, and acquiring 

device information fails.
To setup the Bi-Directional Communication function:

1. Select [Properties] for the printer driver.

2. Open the [Configuration] tab.

3. Select the [Enable Bi-Directional Communication] checkbox.

The printer driver automatically detects the printer on the connected port.

Printer Cannot be Detected
If the printer cannot be detected on the connected port, the [Search Printer] screen is 
displayed. You can select one of the following methods to search for the printer or 
specify a printer address.

• Broadcast – Click this button and then click [Search Details] to specify either a TCP/
IP or IPX broadcast address type. Select [Next] to search for the printer, and then 
click [Finish].
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• Specify Address – Click this button, and click [Next]. Specify the TCP/IP or IPX 
address on the [Specify Address] screen, and then click [Finish].

Advanced Tab Settings
This section describes the settings in the Advanced tab. Select the items in the 
Advanced tab to change the settings.

Settings
Quantity - Specifies the number of output copies.

Collated - Specifies that the output copies be collated for output.
Image Orientation - Specifies the image orientation, portrait or landscape.
Image Color Management - Specifies the image color handling for printing color 
graphics.

ICM Method - Specifies the color graphics printing method.
ICM Intent - Specifies the color image creation method to achieve an optimized 
printing result.

TrueType Fonts - Specifies the font handling for documents containing TrueType 
fonts.

Substitute with Device Font - Substitute TrueType fonts with fonts resident on the 
machine.
Download as Softfont - Download the font to the machine as a softfont.
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Reduce/Enlarge - Specifies the reduction/enlargement ratio as a percentage between 
25 and 400%.
Color - Specifies image reproduction in full color or black and white.
PostScript Output Format - Specifies the default PostScript file output format for 
when saving to a file.

Optimize for Speed - For faster printer processing.
Optimize for Portability - Reduce portability errors.
Encapsulated PostScript - Outputs to an encapsulated PostScript file.
Archive Format - Outputs to an archive format file.

TrueType Font Download Method - Specifies the font handling for documents 
containing TrueType fonts.

Automatic - Automatic font handling.
Outline - Include as vector outlines.
Bitmap - Include as bitmap images.
Native TrueType - Include TrueType fonts in their native format.

PostScript Language Level - Specifies the PostScript language level for compatibility 
with other devices (1, 2, or 3).
Print PostScript Error Message - Specifies whether to print PostScript errors when 
an error occurs in a print job.
Mirror Image - Specifies whether to create mirror images for left-hand and right-hand 
pages when printing.
Feed Orientation - Specifies the paper orientation when printing from the bypass tray. 
When feeding the short edge of the paper first, select [Landscape]. When feeding the 
long edge of the paper, select [Portrait].
Offset - The position of individual jobs or sets of copies are shifted to either side of the 
output tray to enable easy separation.
Front Cover - Specifies the paper tray that the front cover stock is to be fed from.
Back Cover - Specifies the paper tray that the back cover stock is to be fed from.
Transparency Separators - Specifies the separators to be inserted between 
transparencies.

Separator Paper Supply - Specifies the paper tray that transparency separators 
are to be fed from. When [Auto Paper Select] is selected, the tray set on the machine 
is used as the feed destination.
Print on Separators - Specifies whether to print on the transparency separators as 
well as the transparency.
Paper Type (Separators) - Specifies a paper type for the transparency divider.

Image Enhancement - Specifies whether to use the Image Enhancement function. 
Selecting [On] smoothes out boundaries when printing. This reduces jagged edges by 
artificially increasing the resolution of the image. When printing a bitmapped image 
composed of coarse halftone dots, smooth color gradation is impossible in certain 
situations. In this case, select [Off].
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Gray Guaranteed - Specifies printing of achromatic colors in non-raster image areas 
in black toner only.
Image Rotation 180 Degrees - Set the checkbox to rotate the prints by 180°. Default 
is [No Rotation].
Skip Blank Pages - Specifies whether to skip blank pages when printing documents 
that contain blank pages.
Draft Mode - Specifies whether to reduce the amount of toner used when printing 
drafts. When [On] is selected, the overall printed color becomes lighter. This is best for 
printing documents when high print quality is not necessary.
Banner Sheet - Specifies whether to add a banner sheet to the printed output.
When [Printer Default] is selected, the printer settings are used.
When [Print Start Page] is selected, outputs the banner sheet using the start-sheet.
E-mail Job Confirmation - Specifies whether to use the Mail Notify feature to notify 
the end of the print job via e-mail. Default is [Off].

Enter E-Mail Address - Specifies the e-mail address for the Mail Notify feature.
Substitute Tray - Specifies what action to take when the paper for the print size is not 
loaded in the machine.

Printer Default - Use the printer settings. The settings can be confirmed on the 
control panel.
Display Message - Display paper supply messages on the control panel. Printing 
is impossible until paper is supplied.
Use Closest Size (Reduce to Fit) - Selects the closest paper size and automatically 
adjusts the image size as necessary.
Use Closest Size (100%) - Selects the closest paper size and prints the same size 
as the image.
Use Larger Size (Reduce to Fit) - Selects paper larger than the original and 
automatically adjusts the image size as necessary.
Use Larger Size (100%) - Selects paper larger than the original and prints the same 
size as the image.
Select Tray 5 (Bypass) - Feeds from bypass tray.

Custom Paper Auto Orientation - Specifies whether to correct the orientation when 
printing to a custom paper size.
Print Mixed Sized Originals - Specifies whether you are printing mixed sized originals 
for 2 Sided Print.
EMF Spooling - Specifies the spool format of the print data on the hard disk. This 
feature is only available when [Enable advanced printing features] is selected in 
Windows 2000/XP on the print driver's [Advanced] tab, accessed by selecting the 
printer icon and then [Properties] on the Printer folder menu. 
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Paper/Output Tab Settings
This section describes the Paper/Output tab.

NOTE: You can restore defaults by clicking [Defaults].

Job Type
You can specify the print function for Secure Print, Sample Set, and Delayed Print.
Secure Print temporarily stores print jobs in the printer, and then prints them when print 
instructions are received from the control panel.
Sample Set outputs only one copy when multiple copies are specified. If there is no 
problem, the remaining sets can be printed. When only one copy is specified for the 
output, the settings will be changed to [Normal Print] automatically. When multiple 
copies are specified for the output, the remaining copies can be output by an instruction 
from a printer.
Delayed Print temporarily stores print jobs in the printer, and then prints them at the 
scheduled time.
To use Secure Print, Sample Set, or Delayed Print feature, click the [Setup] button to 
input the User ID and passcode for Job Type. The passcode entered appears as 
asterisks (*).
Normal Print - Select when you do not want to output secure prints, a sample set, or 
delayed prints.
Secure Print - Select when you want to output secure prints.
Sample Set - Select when you want to output a sample set.
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Delayed Print - Select when you want to output delayed prints.
See the On-line Help for details on the operation of the printer.
User ID - Displays the User ID for Secure Print and Sample Set. The user ID should be 
of maximum 24 characters.
Enter a 1-12 Digit Secure Print Passcode - Enter the passcode for Secure Print. 
Each digit entered appears as an asterisk (*). Enter the passcode within 12 digits.
Document Name - In Secure Print, Sample Set, and Delayed Print, select the method 
to retrieve the name of the documents stored in the printer. Select [Use Existing Name] 
or [Enter Document Name]. If [Use Existing Name] is selected, the document name will 
be obtained from the application that sends the print command. No manual entry is 
allowed. Document names that have exceeded 24 characters will be truncated. If you 
have selected [Enter Document Name], enter a name in the [New Document Name].
New Document Name - This item is used when [Enter Document Name] is entered in 
[Document Name]. Enter the name of the document stored in the printer. The name 
entered should be within 24 characters.
Start Print Time - Specifies the time that a Delayed Print job will be printed. Place the 
cursor in the hour or minute box and press the up or down triangle to specify the start 
time. You can also set the time by entering the time directly into the boxes. The default 
setting is 00:00.

Settings
Paper Size - Specifies the paper size for printing. When [PostScript Custom Page Size] 
is selected for [Paper Size] on the [Paper / Output] tab, the [Edit...] button becomes 
active. Click this button to specify the dimension for the custom page on the [PostScript 
Custom Size Settings] dialog box. 
Paper Tray - Specifies the paper tray for printing.
Paper Type - Specifies the paper type for printing.
2 Sided Print - Specifies whether to print on both sides of the paper and whether to flip 
the image on the paper.
Output Color - Specifies printing in full color mode or black and white mode.
Stapling - Specifies the stapling location and number of staples. This option requires 
an optional Finisher unit.
Hole Punch - Specifies the punching position. The holes are made based on the output 
orientation of the paper. As a result, the holes may not be punched correctly depending 
on the position of the image. (PS C-series only)
Hole Punch Settings - Specifies the number of holes to punch. (PS C-series only)
Stapling/Hole Punch for Mixed Sizes - Displays the [Stapling/Hole Punch for Mixed 
Sizes] dialog box. You can specify the settings for stapling (all PS printers) and hole 
punching (PS C-series only) for mixed sized documents.
Fold - Specifies the folding method. (PS C-series only)
Output Destination - Specifies the output tray.
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Status
The printer status can be monitored using the Bi-Directional Communication Window, 
displayed by selecting the [Status] button on the [Paper/Output] tab. For details on the 
Bi-Directional Communication functions, refer to the PostScript driver online Help.
When the Bi-Directional Communication function is setup, the  icon and the [Status] 
button is displayed on the [Paper/Output] tab. For instructions on how to setup Bi-
Directional Communication, refer to Bi-Directional Communication Setup on page 39.

Image Options Tab Settings
This section describes the Image Options tab.

NOTE: You can restore defaults by clicking [Defaults].

Settings
Image Quality - Specifies the print quality of the document. Select [High Speed] for 
quick output, [High Quality] for high quality output regardless of the speed, or [High 
Resolution] for printing in Decomposer resolution. 
Brightness - Adjusts the level of brightness applied to the printed images.

Basic Features
Image Types - Specifies the color adjustment printing mode optimized for the input 
type.

Standard - Printing is optimized for business documents containing text and graphs.



4 Operation with Windows 2000, Windows XP and Windows Server 2003

46 Xerox WorkCentre 7228/7235/7245 PostScript® User Guide

Photos - Printing is optimized for high-gradation images to best reproduce photos.
Presentation - Printing is optimized for presentation materials to produce vivid 
colors.
Web Pages - Printing is optimized for low-resolution images such as web pages and 
screen displays.
CAD - Printing is optimized for reproducing fine lines and colored text.
Off - Printing occurs with no color adjustment.

Screen - Specifies the printer engine screening mode.
Color Balance - Displays a screen that allows you to adjust the intensity of the color in 
highlights, midtones, and shadows.

Advanced Features/Image Adjustment
RGB Color Correction - Specifies the RGB color correction method.
RGB Gamma Correction - Specifies the color adjustment input source gamma value.
Source RGB Profile - Specifies the display or working color space for accurate 
reproduction of RGB color.
RGB Color Temperature - Specifies the RGB color temperature.
CMYK Color Correction - Specifies the color correction target ink type for CMYK.
Target Paper - Specifies the type of paper for CMYK color correction. This is not the 
paper for printing. 

Layout Tab Settings
This section describes the settings in the Layout tab. 

NOTE: You can restore defaults by clicking [Defaults].
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Settings
Multiple-Up - Prints multiple consecutive pages of a document on a single sheet of 
paper.

Draw Outlines - Draws a border around each page image printed on a single sheet 
of paper using the Multiple-Up feature.

Fit to New Paper Size - Specifies the paper size on which to print the image.
Image Shift - Specifies the image shift position for a binding margin. Specify the edge 
position and the extent of the image shift on [Side 1] of the paper. You can also specify 
a margin for [Side 2] for 2 sided printing along the same edge of the paper.

How to Use Help

The following describes how to use Help. 

1. Click  and a ? mark appears next to the pointer. You can then click items for 
which you need explanations, opening a pop-up window that contains relevant 
information. Click inside the pop-up window to close it.

2. Click [Help], an explanation of the current tab appears as Help information.
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5 Operation on Macintosh Computers

• About the Software
– Bundled Software
– Hardware/Software Requirements

• Installing the Adobe PostScript Printer Driver
– Installation Procedure (Mac OS 9.x or earlier)
– Setting the Printer Driver (Mac OS 9.x or earlier)
– Installation Procedure (Mac OS X)
– Adding a Printer (Mac OS X)

• Installable Options
– For Mac OS 9.x or earlier
– For Mac OS X

• Printer Specific Options Settings
– For Mac OS 9.x or earlier
– For Mac OS X

• Installing the Screen Fonts

About the Software

This section describes the Macintosh software that is included on the PostScript Driver 
Library CD-ROM.
NOTE: When using AppleTalk protocol to print from Macintosh, set the EtherTalk port 
to Enable on the control panel.

Bundled Software
Insert the CD-ROM and double-click the WorkCentre-PS icon to display the window. 
The following items are contained in the folder:
AdobePS Printer Driver (ver. 8.7 and 8.8) and PPD files - Adobe PostScript driver 
and PPD files (for Macintosh).
PPD Installer - The PPD file installer for Mac OS X 10.2.
Xerox Installer - The plug-in driver and PPD file installer for Mac OS X 10.3.3 through 
10.4.3.
ColorSync - ColorSync ICC profiles.
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Adobe Screen Fonts - Contains 117 PostScript fonts and 19 TrueType fonts, which 
are standard for PostScript 3 printers. In addition, 37 PostScript fonts for the Central 
European (CE) character set are included.
ATM (Adobe Type Manager) (ver. 4.5.2) - Helps you to install typefaces and activate 
and manage your fonts.
Adobe Reader - Allows you to view and print PDF files on all major computing 
platforms.

Hardware/Software Requirements
The minimum system requirements for the Macintosh printer driver and the utility are 
described below.

Computer System
• Macintosh

• Power Macintosh

Basic Software
• Adobe PostScript Driver 8.7 - Mac OS 8.5 and 8.5.1

• Adobe PostScript Driver 8.8 - Mac OS 8.6 through 9.2.2

• PPD Installer - Mac OS X 10.2

• Xerox Installer - Mac OS X 10.3.3 through Mac OS X 10.4.3
NOTE: When using Mac OS X, launch the Classic environment to run the 
applications.

Installing the Adobe PostScript Printer Driver 

This section describes how to install the Adobe printer driver and how to set the printer 
driver for this machine. There are two steps to install the printer driver. Firstly, use the 
installer enclosed on the CD-ROM to install the printer to the Macintosh. Then, 
configure the printer driver according to the printer used.

Installation Procedure (Mac OS 9.x or earlier)
This section describes the procedures for installing the Adobe PostScript printer driver.
As an example, here is the procedure to install Adobe PostScript 8.8.

1. Insert the PostScript Driver Library CD-ROM in the CD-ROM drive. 

The WorkCentre-PS icon appears on the desktop.

2. Double-click [WorkCentre-PS]. 
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3. Double-click the [PrinterDriver] folder for your printer model, and then the “Adobe 
PostScript 880” folder. 

4. Double-click [Adobe PostScript Installer 8.8].

5. When the Installer opens, click [Continue]. 

6. Read through the license agreement carefully and if you have no objections to it, 
click [Accept]. 

7. Confirm the Install Location for the [AdobePS Components] folder and change it if 
necessary, then click [Install].
Installation begins.

8. When the dialog box showing installation has completed appears, click [Continue] 
or [Quit]. 

This completes the installation.
Proceed to Setting the Printer Driver (Mac OS 9.x or earlier) on page 51 to continue.

Setting the Printer Driver (Mac OS 9.x or earlier)
When you finish installing the Adobe PostScript printer driver, set the PostScript Printer 
Description (PPD) file for this machine to the printer driver.
The printer driver controls the functions of this machine based on the information in the 
PPD file.

1. Make sure that the machine is on.

2. Check that the machine’s EtherTalk port is set to Enable.

You can check the EtherTalk settings in the System Settings List. See User Guide 
for details about how to print the System Settings List.

3. On the Apple menu select [Chooser], then click [AdobePS].

4. Select your printer from the Select a PostScript Printer list box, which appears to 
the right of the Chooser, then click [Setup].

NOTE: You must be connected to the printer for its name to appear in the list box.
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This automatically searches for the printer and sets the PPD file.
If the search for the PPD file is not automatically performed:
(1) Click [Select PPD].
(2) Select your printer model in the list, then click [Select]. 

NOTE: When Finisher C or Finisher C with Booklet Output Tray is installed, select the 
model number with ‘C’ at the end.

The PPD file for this machine is set.

5. Click [Configure] to set the installable options.

See Installable Options on page 55 for details about the options.
NOTE: You can change the print settings after you install the printer driver.

NOTE: To use the options, it is necessary to set [Configure]. Always set this according 
to the configuration of your machine.

6. Click [OK]. Click [OK] once more in the screen displayed.

7. Close the Chooser.
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Installation Procedure (Mac OS X)
This section describes how to install the PostScript Printer Description (PPD) file for the 
Macintosh operating system, Mac OS X 10.3.3 through Mac OS X 10.4.3.
NOTE: A printer driver does not need to be installed on Mac OS X. It uses a resident 
driver provided with the operating system.

1. Insert the PostScript Driver Library CD-ROM in the CD-ROM drive.

The WorkCentre-PS icon appears on the desktop.

2. Double-click [WorkCentre-PS].

The WorkCentre-PS window opens.

3. Open the [Mac OS X] folder.

The Mac OS X window opens. 

4. Double-click [Xerox Installer].

The installer starts and the Authenticate window opens.

5. Enter the Administrator’s user name and password, then click [OK].

The Xerox Installer screen opens.

6. Click [Install] to start the installation.

7. Read through the license agreement carefully and if you have no objections to it, 
click [Accept].

8. Confirm the Install Location and change it if necessary, then click [Install].

9. When the dialog box showing installation has completed appears, click [Quit].

This completes the installation.
Proceed to Adding a Printer (Mac OS X) on page 53.

Adding a Printer (Mac OS X)
After the PPD file has been installed, set the PPD file for the printer driver, and then 
add the printer. The printer driver controls the printer functions based on the information 
in the PPD file. 

1. Make sure that the machine is on.

2. Check that the machine’s port is set to Enable.

– When using AppleTalk, set the EtherTalk port to Enable.
– When using IP Printing, set the LPD port to Enable.
You can check the EtherTalk and LPD settings in the System Settings List. See the 
User Guide for details about how to print the “System Settings List.”

3. Start [Printer Setup Utility].

NOTE: You can find Printer Setup Utility in the Utilities folder in the Applications folder.
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4. When the Printer List screen opens, click [Add].

5. Select the protocol used to connect the printer.

When using AppleTalk®

1. Select [AppleTalk] from the menu, and specify the zone for the printer being used. 

2. Select the printer you are using from the list.

3. Select [Auto Select] from Printer Model.

4. Click [Add].

When using IP Printing
You can select the printer by setting IP address as well as by using Bonjour or 
Rendezvous. When directly setting IP address, follow the steps below.

1. Select [IP Printing] from the menu, and enter the IP address for the printer being 
used in Printer’s Address.

2. Enter the IP address or DNS name for the printer in the Printer Address field.
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3. Select [Xerox] from Printer Model, and select the machine in the [Model Name] 
list.

NOTE: When Finisher C or Finisher C with Booklet Output Tray is installed, select the 
model number with ‘C’ at the end.

4. Click [Add].

This completes the addition of a printer.
When automatically setting the printer by using Bonjour or Rendezvous, follow the 
steps below.

1. Select [Bonjour] or [Rendezvous] from the menu.

2. Select the printer you are using from the list.

3. Select the required items according to the screen to automatically set the printer.

Installable Options

This section describes the installable options settings corresponding to the hardware 
configuration of the printer.

For Mac OS 9.x and earlier
This section describes the installable options for operating systems Mac OS 9.x and 
earlier.
NOTE: Usually, Installable Options are automatically set according to the bidirectional 
communications of this machine. You do not have to change the settings.

1. Select the printer using the Chooser and click [Setup].

The Current Printer Description File (PPD) Selected dialog box appears.

2. Click [Configure].

The Installable Options list appears.
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3. Set the option menu items in Installable Options, and click [OK].

For Mac OS X
This section describes the installable options for Mac OS X.

1. Click [Printers] on the Printer Setup Utility menu bar, and select [Show Info].

2. Select [Installable Options], and select the options that have been installed on the 
printer. 

Settings
Paper Tray Configuration - Specifies the paper tray type installed on the machine.
When [4-Tray] is selected, the standard paper trays are installed.
When [4-Tray (High Capacity)] is selected, the high-capacity trays are installed.
Output Options - Specifies whether the Finisher output unit is installed for WorkCentre 
7228/7235/7245 PS printers, and whether the Finisher (2 Holes/4 Holes) or Finisher (3 
Holes) is installed for WorkCentre 7228/7235/7245 PS C-series printers.
Booklet Output Tray - Specifies whether the Booklet Output Tray (optional) is 
installed. (PS C-series only)
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Paper Size Settings - Specifies the paper size group for different areas to enable the 
selection of paper size common to that location.
Memory - Specifies the amount of printer memory.

Printer Specific Driver Settings

This section describes the settings that relate specifically to the printer. The settings 
available vary depending on which hardware options have been installed. See 
Installable Options on page 55.

For Mac OS 9.x and earlier

1. On the File menu of the application, click [Print].

The Print dialog box appears.

2. Select [Printer Specific Options]. 

3. Specify the functions that you want to set.
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Settings
Output Destination - Specifies the output tray.
Collated - Specifies whether to collate a multiple-page file when a job is printed.
Paper Type - Specifies the paper type for printing.
Output Color - Specifies printing in full color mode or black and white mode.
Stapling - Specifies the stapling location and number of staples. This option requires 
an optional Finisher unit.
Hole Punch - Specifies the punching position. The holes are made based on the output 
orientation of the paper. As a result, the holes may not be punched correctly depending 
on the position of the image. (PS C-series only)
Hole Punch Settings - Specifies the number of holes to punch. (PS C-series only)
Fold - Specifies the folding method. (PS C-series only)
Offset - The position of individual jobs or sets of copies are shifted to either side of the 
output tray to enable easy separation.
Feed Orientation - Specifies the paper orientation when printing from the bypass tray. 
When feeding the short edge of the paper first, select [Landscape]. When feeding the 
long edge of the paper, select [Portrait].
Front Cover - Specifies the paper tray that the front cover stock is to be fed from.
Back Cover - Specifies the paper tray that the back cover stock is to be fed from.
Print on Separators - Specifies whether to print on the transparency separators as 
well as the transparency.
Separator Paper Supply - Specifies the paper tray that transparency separators are 
to be fed from. When [Auto Paper Select] is selected, the tray set on the machine is 
used as the feed destination.
Paper Type (Separators) - Specifies a paper type for the transparency divider.
Print Mixed Sized Originals - Specifies whether you are printing mixed sized originals 
for 2 Sided Print.
Image Enhancement - Specifies whether to use the Image Enhancement function. 
Selecting [On] smoothes out boundaries when printing. This reduces jagged edges by 
artificially increasing the resolution of the image. When printing a bitmapped image 
composed of coarse halftone dots, smooth color gradation is impossible in certain 
situations. In this case, select [Off].
Gray Guaranteed - Specifies printing of achromatic colors in non-raster image areas 
in black toner only.
Draft Mode - Specifies whether to reduce the amount of toner used when printing 
drafts. When [On] is selected, the overall printed color becomes lighter. This is best for 
printing documents when high print quality is not necessary.
Substitute Tray - Specifies what action to take when the paper for the print size is not 
loaded in the machine.

Printer Default - Use the printer settings. The settings can be confirmed on the 
control panel.
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Display Message - Display paper supply messages on the control panel. Printing 
is impossible until paper is supplied.
Use Closest Size (Reduce to Fit) - Selects the closest paper size and automatically 
adjusts the image size as necessary.
Use Closest Size (100%) - Selects the closest paper size and prints the same size 
as the image.
Use Larger Size (Reduce to Fit) - Selects paper larger than the original and 
automatically adjusts the image size as necessary.
Use Larger Size (100%) - Selects paper larger than the original and prints the same 
size as the image.
Select Tray 5 (Bypass) - Feeds from bypass tray.

Skip Blank Pages - Specifies whether to skip blank pages when printing documents 
containing blank pages.
Custom Paper Auto Orientation - Specifies whether to correct the orientation when 
printing to a custom paper size.
Image Quality - Specifies the print quality of the document. Select [High Speed] for 
quick output, [High Quality] for high quality output regardless of the speed, or [High 
Resolution] for printing in Decomposer resolution. 
Brightness - Adjusts the level of brightness applied to the printed images.
Image Type - Specifies the color adjustment printing mode optimized for the input type.

Standard - Printing is optimized for business documents containing text and graphs.
Photos - Printing is optimized for high-gradation images to best reproduce photos.
Presentation - Printing is optimized for presentation materials to produce vivid 
colors.
Web Pages - Printing is optimized for low-resolution images such as web pages and 
screen displays.
CAD - Printing is optimized for reproducing fine lines and colored text.
Off - Printing occurs with no color adjustment.

Screen - Specifies the printer engine screening mode.
RGB Color Correction - Specifies the RGB color correction method.
Source RGB Profile - Specifies the display or working color space for accurate 
reproduction of RGB color.
RGB Gamma Correction - Specifies the color adjustment input source gamma value.
RGB Color Temperature - Specifies the RGB color temperature.
CMYK Color Correction - Specifies the color correction target ink type for CMYK.
Target Paper - Specifies the type of paper for CMYK color correction. This is not the 
paper for printing. 
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For Mac OS X

Job Type Settings

You can specify the print function for Secure Print, Sample Set, and Delayed Print.
Secure Print temporarily stores print jobs in the printer, and then prints them when print 
instructions are received from the control panel.
Sample Set outputs only one copy when multiple copies are specified. If there is no 
problem, the remaining sets can be printed.
Delayed Print temporarily stores print jobs in the printer, and then prints them at the 
scheduled time.
To use the Secure Print, Sample Set, or Delayed Print feature, input the User ID and 
passcode for Job Type. The passcode entered appears as dots.
NOTE: Secure Print, Sample Set, and Delayed Print are supported on Mac OS X 10.3 
and Mac OS X 10.4 only.

Normal Print - Select when you do not want to output secure prints, a sample set, or 
delayed prints.
Secure Print - Select when you want to output secure prints.
Sample Set - Select when you want to output a sample set.
NOTE: The Collated setting must be selected in the Page Setup tab when using Print 
Type.

Delayed Print - Select when you want to output delayed prints.
See the On-line Help for details on the operation of the printer.
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User ID - Displays the User ID for Secure Print and Sample Set. The user ID should be 
of maximum 24 characters.
Enter a 1-12 Digit Secure Print Passcode - Enter the passcode for Secure Print. 
Each digit entered appears as a dot. Enter the passcode within 12 digits.
Document Name - In Secure Print, Sample Set, and Delayed Print, select the method 
to retrieve the name of the documents stored in the printer. Select [Use Existing Name] 
or [Enter Document Name]. If [Use Existing Name] is selected, the document name will 
be obtained from the application that sends the print command. No manual entry is 
allowed. Document names that have exceeded 24 characters will be truncated. If you 
have selected [Enter Document Name], enter a name in the [New Document Name].
New Document Name - This item is used when [Enter Document Name] is entered in 
[Document Name]. Enter the name of the document stored in the printer. The name 
entered should be within 24 characters.
Start Print Time - Specifies the time that a Delayed Print job will be printed. Place the 
cursor in the hour or minute box and press the up or down triangle to specify the start 
time. You can also set the time by entering the time directly into the boxes. The default 
setting is 00:00.

Job Accounting Settings

NOTE: These functions are supported on Mac OS X 10.3 and Mac OS X 10.4 only.

Account Mode - Specifies if all users or only System Administrators can change the 
authentication related settings.
Detailed User Settings - Sets the authentication information.

Use Default User Settings - The values set in this feature are used as the 
authentication parameters.
– Specify User ID - Select how to specify the User ID.
– User ID - Enter a User ID.
– Passcode - Enter the Passcode for the User ID.
– Account ID - Enter an Account ID.
– Billing ID - Enter a User ID for Charge Print.
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– Passcode - Enter the Passcode for the Billing ID.
Prompt User for Settings - Select this feature to display the [Enter User Details] 
dialog-box each time you start printing. The user is then required to enter 
authentication information such as their User ID or the Billing ID.
– Display Previous User Details - Check the box to store the user details entered 

in the [Enter User Details] dialog box. These details will be displayed as the 
default entry the next time the window opens.

– Hide User_ID - Check the box to specify whether a user ID is to be displayed or 
hidden when it is entered.

– Hide Account ID - Check the box to specify whether an account ID is to be 
displayed or hidden when it is entered.

Image Options Settings

NOTE: These functions are supported on Mac OS X 10.3 and Mac OS X 10.4 only.

Output Color - Specifies printing in full color mode or black and white mode.
Image Quality - Specifies the print quality of the document. Select [High Speed] for 
quick output, [High Quality] for high quality output regardless of the speed, or [High 
Resolution] for printing in Decomposer resolution. 
Brightness - Adjusts the level of brightness applied to the printed images.
Screen - Specifies the printer engine screening mode.
Color Balance - Displays a screen that allows you to adjust the intensity of the color in 
highlights, midtones, and shadows.

Basic Features
Image Type - Specifies the color adjustment printing mode optimized for the input type.



5 Operation on Macintosh Computers

Xerox WorkCentre 7228/7235/7245 PostScript® User Guide 63

Standard - Printing is optimized for business documents containing text and graphs.
Photos - Printing is optimized for high-gradation images to best reproduce photos.
Presentation - Printing is optimized for presentation materials to produce vivid 
colors.
Web Pages - Printing is optimized for low-resolution images such as web pages and 
screen displays.
CAD - Printing is optimized for reproducing fine lines and colored text.
Off - Printing occurs with no color adjustment.

Advanced Features/Image Adjustment
RGB Color Correction - Specifies the RGB color correction method.
RGB Gamma Correction - Specifies the color adjustment input source gamma value.
Source RGB Profile - Specifies the display or working color space for accurate 
reproduction of RGB color.
RGB Color Temperature - Specifies the RGB color temperature.
CMYK Color Correction - Specifies the color correction target ink type for CMYK.
Target Paper - Specifies the type of paper for CMYK color correction. This is not the 
paper for printing. 

Printer Features Settings

Output Destination - Specifies the output tray.
Paper Type - Specifies the paper type for printing.
Stapling - Specifies the stapling location and number of staples. This option requires 
an optional Finisher unit.
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Hole Punch - Specifies the punching position. The holes are made based on the output 
orientation of the paper. As a result, the holes may not be punched correctly depending 
on the position of the image. (PS C-series only)
Hole Punch Settings - Specifies the number of holes to punch. (PS C-series only)
Fold - Specifies the folding method. (PS C-series only)
Offset - The position of individual jobs or sets of copies are shifted to either side of the 
output tray to enable easy separation.
Feed Orientation - Specifies the paper orientation when printing from the bypass tray. 
When feeding the short edge of the paper first, select [Landscape]. When feeding the 
long edge of the paper, select [Portrait].
Front Cover - Specifies the paper tray that the front cover stock is to be fed from.
Back Cover - Specifies the paper tray that the back cover stock is to be fed from.
Print Mixed Sized Originals - Specifies whether you are printing mixed sized originals 
for 2 Sided Print.
Image Enhancement - Specifies whether to use the Image Enhancement function. 
Selecting [On] smoothes out boundaries when printing. This reduces jagged edges by 
artificially increasing the resolution of the image. When printing a bitmapped image 
composed of coarse halftone dots, smooth color gradation is impossible in certain 
situations. In this case, select [Off].
Gray Guaranteed - Specifies printing of achromatic colors in non-raster image areas 
in black toner only.
Draft Mode - Specifies whether to reduce the amount of toner used when printing 
drafts. When [On] is selected, the overall printed color becomes lighter. This is best for 
printing documents when high print quality is not necessary.
Substitute Tray - Specifies what action to take when the paper for the print size is not 
loaded in the machine.

Printer Default - Use the printer settings. The settings can be confirmed on the 
control panel.
Display Message - Display paper supply messages on the control panel. Printing 
is impossible until paper is supplied.
Use Closest Size (Reduce to Fit) - Selects the closest paper size and automatically 
adjusts the image size as necessary.
Use Closest Size (100%) - Selects the closest paper size and prints the same size 
as the image.
Use Larger Size (Reduce to Fit) - Selects paper larger than the original and 
automatically adjusts the image size as necessary.
Use Larger Size (100%) - Selects paper larger than the original and prints the same 
size as the image.
Select Tray 5 (Bypass) - Feeds from bypass tray.

Skip Blank Pages - Specifies whether to skip blank pages when printing documents 
containing blank pages.
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Custom Paper Auto Orientation - Specifies whether to correct the orientation of the 
custom paper.
Transparency Separators - Specifies the separators to be inserted between 
transparencies.

Print on Separators - Specifies whether to print on the transparency separators as 
well as the transparency.
Separator Paper Supply - Specifies the paper tray that transparency separators 
are to be fed from. When [Auto Paper Select] is selected, the tray set on the machine 
is used as the feed destination.
Paper Type (Separators) - Specifies a paper type for the transparency divider.

Installing the Screen Fonts

This section explains how to install the fonts in the Screen Font folder.
It is recommended that all other applications are closed before installing the fonts. 
Otherwise, a warning message appears between steps 5 and 6.

1. Start Macintosh and insert the PostScript Driver Library CD-ROM into the CD-
ROM drive.

2. Double-click the [WorkCentre-PS] icon followed by the Screen Font folder and 
then the [PS3 Fonts Installer]. 

3. When the Installer window appears, click [Continue].

The license agreement dialog appears.

4. Read through the agreement carefully and if you have no objections to it, click 
[Accept].
The PS3FontsInstaller dialog box appears.

5. You may select [Easy Install] or [Custom Install].

Easy Install - installs all the fonts provided in the Screen Font folder. 
Custom Install - installs the selected fonts only. Simply click on the disclosure 
triangle beside the four categories of fonts to display the fonts in each category and 
then check the fonts to be installed. For example, the diagram below shows that 
Arial CE of the CE TrueType fonts is selected.
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A warning message will appear if you did not quit all other applications before 
performing the font installation.

6. Click [Install].

The installation of the fonts begins.
After the installation, you have to restart your Macintosh before the fonts can be used.
Store your CD-ROM in a safe place.
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6 Appendix

Cautions and Limitations

Troubleshooting
See the User Guide for error codes and error messages displayed on the control panel. 
See the User Guide for how to deal with paper jams.

Print operation
The printer driver allows you to make selections to print on custom paper and postcards 
using duplex and/or the stapling feature to the Finisher Tray. However, these features 
cannot be used when printing on custom paper or postcards.
You can feed custom paper from the bypass tray only. However, when you select 
custom paper, the Paper Source selection does not change to Manual Feed 
automatically. Please select Manual Feed yourself.
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